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01	 General

1.1	 About the document

The document relates to Store Flex Release 1.6.

This document describes the design of the architecture 
variant Store Flex, which is an advanced lighting control 
solution for retail applications. It is the most complete 
lighting solution in the market, capable of handling 
small optimized solutions up to highly advanced 
installations covering multiple areas, zones, presets and 
schedules.

1.2	 Intended audience

The information in this guide is specifically intended for 
System Centers, installers, site engineers, and customer 
IT departments.

The instructions are placed in logical chapters and in 
chronological order. When following the procedures, 
you must be able to design, install and commission a 
functioning lighting system.
 

1.3	 Related documents

Refer to other documents for more information:

Mini Kit 1.1
•	 Quick start guide
	 describes the installation, commissioning, 

configuration, and usage of the lighting system.
Kit 2.2 (with gateway or touchscreen)
•	 Quick start guide
	 describes the installation, commissioning, and 

configuration of the lighting system.
•	 User guide for Store Control UI
	 describes the usage and configuration of the user 

interface of the lighting system.
Flex 1.6
•	 System guide
	 describes the system design and how this design can 

support the requirements of a customer.
•	 User guide for Store Control UI 

describes the usage and configuration of the user 
interface of the lighting system.
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1.4	 Abbreviations

The following abbreviations are used throughout the 
document:

Abbreviation Explanation

BLA Base Link Area

BMS Building Management System

BoM Bill of Materials

DALI Digital Addressable Lighting Interface 
communication protocol

DMX Digital MultipleXed communication protocol

DSI Digital Serial Interface communication protocol

HVAC Heating, ventilation, and air conditioning

IR Infrared

PDDEG-S Philips Dynalite DIN-rail Ethernet Gateway – 
Supervisor (in short: Ethernet Gateway Supervisor)

PDEB Philips Dynalite Ethernet Bridge 
(in short: Ethernet Bridge)

PDEG Philips Dynalite Ethernet Gateway 
(in short: Ethernet Gateway)

PE Photo electric

PIR Passive Infrared

Abbreviation Explanation

PWM Pulse-Width Modulation phase cut dimming

STP Shielded Twisted Pair

UI User interface

BSR Business Support Request

C4CS Ticketing system capturing customer tickets

C-ROC Signify Customer Remote Operating Center

C-SAT Customer Satisfaction

CSI Certified System Integrator

GSO Global Software Operations

OTRS Ticketing system capturing corporate tickets

SAP Enterprise software for customer management
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1.5	 Terms and definitions

The following terms and definitions are used 
throughout the document:

Term Definition

Format A group of sites with similar design or style (In retail 
also known as the formula). Every site belongs to 
only one format (e.g., supermarket, convenience 
store).

Area A lighting control area (for example Sales floor or 
Back of house)

Scene A specific set of light levels that can be edited and 
recalled, sometimes also referred to as Preset.

Logical channel A lighting control sub-zone included inside an area 
(like Bakery spots or Bakery counter)

Schedules Set of all scheduled events (simple events, special 
events, holidays) that automatically control the 
lighting of the sites in a specific format

Store Control UI User interface of the system used on a tablet or 
touchscreen (in short: UI)
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2.1	 System architecture

The Store Flex system is an onsite lighting system that is 
tailored to the needs of the customer. It can be applied 
in all store formats but is specifically aimed at the 
supermarket and hypermarket segment. 

The system is based on Dynalite components that allows 
for wired, wireless or hybrid control control solutions 
like DALI, Zigbee, 0-10V or relay switching to bring the 
highest level of lighting control to a store.

2.1.1	 Benefits
While being targeted at retailers that value one or more 
of the principles of the system, expected key benefits are:
•	 Maximize energy savings by easy scene and schedule 

management
•	 Improve in-store ambiance
•	 Easy to use user interface for controls and 

configuration of the system
•	 Easy installation and maintenance
•	 Future proof and upgradable

Upgrade scenario
Upgrade existing sites to grow the system with the 
store, expanding on features and insights without 
compromises on usability. 

It is also possible to connect different sites to the cloud 
and start using Multisite System Manager, centrally 
managing and monitoring the lighting at all sites, 
making sure that all have the same look and feel.
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2.1.2	 Architecture
All architectures operate onsite with a wired 
architecture, consisting of Philips Dynalite lighting 
control components.

Gateway
The Ethernet Gateway (PDDEG-S) functions as the 
‘central store controller’, interconnecting the onsite 
hardware. The device:
•	 Provides access to the Store Control UI that enables 

scenes and schedules management;
•	 A connected Wireless Access Point enables the Store 

Control UI to be accessible via a mobile device;
•	 Offers a fully futureproof system that is ready to 

upgrade to Multisite, where the PDDEG-S will act as 
Site Gateway, safeguarding secure cloud connection.

•	 Tailored to the needs of the customer.
•	 Supports BACnet, integrating with Building 

Management Systems (BMS).

	 Note
The router and the mobile device (tablet) are not part 
of the Signify delivery.

	 2.1	 System architecture
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Dynet / RS-485

Ethernet
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PDEG Ethernet Gateway or PDTS Touchscreen
Alternatively, the PDEG and PDTS can also be used as central 
store controllers. 
•	 The devices include similar features as the PDDEG-S, 

providing access to the Store Control UI that enables 
scenes and schedules management.

	 Note
•	 Only one device can act as the central store controller.
•	 It is possible to combine a PDTS with a PDDEG-S  

(for example when using wireless controls), but the 
Store Control UI can only be used on one device.

•	 A DDNP1501 Network power supply is required.
•	 The PDEG Ethernet Gateway can connect to a Wireless 

Access Point to enable the Store Control UI to be 
accessible via a mobile device.

•	 The PDTS Touch Screen offers a local wall mounted user 
interface for the Store Control UI.

•	 When using a PDTS touchscreen in combination with a 
PDDEG-S or PDEG Ethernet Gateway, the PDTS can then 
only be used as a scene controller. In this specific case, 
configuration of schedules is not possible.

•	 Upgrade to Multisite is not possible without installation 
of a PDDEG-S that requires complete recommissioning of 
the system.

DALI
Dynet / RS-485
Ethernet
Power

Router

DDNP1501

PDEG

DDNP1501

PDTS

Tablet
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2.1.3	 Wireless architecture
The wireless architecture is an extension to the wired 
architecture of Store Flex.

As in wired Store Flex, the PDDEG-S functions as the 
‘central store controller’. A PDDEG-S Ethernet Gateway: 
•	 Connects up to 25 PDZG-E Wireless Gateways to the 

system by using its Ethernet connectivity capabilities.
•	 Ensures the secure connection between the PDZG-E 

Wireless Gateways and the rest of the Dynet network

The PDZG-E Wireless Gateway:
•	 Links the wireless Zigbee network over Ethernet to 

the wired Dynet network;
•	 Connects up to 200 wireless nodes (luminaires and/or 

transceivers) via Zigbee

	 Note
The router and the mobile device (tablet) are not part 
of the Signify delivery.

Switch*

DUS360* 
Sensor

Wired load
controller*

PDDEG-S
Router*

DDMIDC8*

Tablet*

Wired load
controllers*

PDZG-E PDZG-E

Antumbra Display*PDTS*

DALI
Dynet / RS-485

Ethernet
Power

* Dependent on configuration
* Zigbee
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Store Flex wireless supports easy commissioning with 
the Philips Dynalite Enabler app, using the Bluetooth 
functionality of each luminaire and/or node.
 

	 Note
As an alternative, also the PDTS Touchscreen can be 
used as ‘central store controller’. However, a PDDEG-S 
Ethernet Gateway is still required to ensure the secure 
connection between the PDZG-E Wireless Gateways 
and the Dynet network.

	 2.1	 System architecture
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2.1.4	 Controllers

Store Flex
The correct combination of control components creates 
a robust controller network and brings the highest level 
of lighting control flexibility to a store, enabling:
•	 Wired load controllers (for example: DALI Broadcast, 

DALI Addressable, DMX, 0-10V, Relay)
•	 Wireless devices (Philips wireless luminaires, SNS441 

IA transceivers)
•	 Daylight & occupancy sensing via Dynet sensors to 

dynamically adjust lighting to local conditions
•	 Scene control with dimming & zoning
•	 Local manual override, plus integrations with 

Building Management Systems (BMS), alarm systems, 
etcetera

	 Note
Currently, sensing and data collection is not 
supported via wireless nodes like the SNS210 IA.  
It is possible to use Dynet or DALI sensors instead.

2.1.5	 Topology

Wired architecture
In the wired architecture, the central store controller 
connects to the control equipment by means of Dynet 
via RS-485 or Ethernet cabling. Luminaires are connected 
to the load controllers, depending on the type of 
luminaire, by means of power and/or control cables.

Wireless architecture
In the wireless architecture, the function of the load 
controllers is taken over by the PDZG-E Wireless 
Gateway, that connects wireless devices to the 
associated network. The Wireless Gateways are via 
Ethernet connected to the PDDEG-S Ethernet Gateway. 
Each Wireless Gateway can join a wireless network that 
can consist of up to 200 wireless nodes. 

	 2.1	 System architecture
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Wireless Group Control (WGC) is also possible, which is 
wireless control of a DALI broadcast group. This can be 
achieved by using one of the following devices:
•	 SNS441 IA transceiver with a Xitanium SR Bridge
	 A SR transceiver connected to the SR interface of 

the Bridge enables control of a group of luminaires 
via the DALI interface of the Bridge and the mains 
relay integrated in the Bridge. The Bridge supports a 
maximum of 20 DALI drivers per SR Bridge or up to 
400 VA switching capacity . See the specifications of 
the SR Bridge for all details.

•	 SNS441 IA transceiver with a DALI Extender
	 Extends the SR bus, to which a SR transceiver can 

be connected, to the DALI bus, enabling multiple 
applications. The DALI Extender supports up to 
20 DALI drivers. See the specifications of the DALI 
Extender for all details.

	 Note
•	 It is possible to use the SNS441 IA in combination 

with SR-driver as applied in certain luminaire 
ranges. Check the documentation of the 
SNS441 IA for more information.

•	 Currently, sensing and data collection is not 
supported via wireless nodes like the SNS210 IA.  
It is possible to use Dynet or DALI sensors instead.

	 2.1	 System architecture
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2.2	 Formats and application

2.2.1	 Formats

Express & convenience

Convenience stores and express formats are 
smaller local stores.

Characteristics

•	 Stores with a smaller assortment
•	 Convenient formats are found in smaller 

villages, city centers or for example  
holiday resorts

•	 Express formats are typically found in places 
with high traffic

Typical size

Floor area: ≤ 500 m2

Light points: ≤ 200

Supermarket

Stores in this format are typically larger 
supermarkets, fashion, and DIY retail formats.

Characteristics

•	 Stores with a large assortment
•	 Supermarkets and fashion retails found in all 

kinds of shopping areas, e.g., city centers
•	 DIY retails mostly found at the edges of a town

Typical size

Floor area: 500 to 3,000 m2

Light points: 200 to 1,000

Hypermarket

This format includes all very large stores that 
often have more assortments than groceries 
alone, or department stores.

Characteristics

•	 Stores with multiple assortments
•	 Hypermarkets/Wholesalers mostly found at the 

edges of a town
•	 Department stores often in the city centers

Typical size

Floor area: 3,000 to 10,000+ m2

Light points: 1,000 to 5,000+
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2.2.2	 Typical application examples

Hypermarket

DALI addressable
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 80x DDBC120-DALI
or: 28x DDBC320 DALI

Relay control 3x DDRC1220

Dry contact input 1x DDMIDC8

Multi-sensor 15x DUS360CR

DALI broadcast
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 25x DDBC120-DALI

Relay control 3x DDRC1220

Dry contact input 1x DDMIDC8

Multi-sensor 15x DUS360CR

Supermarket

DALI addressable
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 16x DDBC120-DALI
or: 6x DDBC320 DALI

Relay control 1x DDRC1220
Dry contact input 1x DDMIDC8

Multi-sensor 3x DUS360CR

DALI broadcast
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 1x DDBC1200

Relay control 1x DDRC1220

Dry contact input 1x DDMIDC8

Multi-sensor 3x DUS360CR

Express & convenience

DALI addressable
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 3x DDBC120-DALI 
or: 1x DDBC320 DALI

Relay control 1x DDRC420

DALI broadcast
Controls

Ethernet gateway 1x PDDEG-S/PDEG/PDTS

DALI control 1x DDBC1200

Relay control 1x DDRC420

	 2.2	 Formats and application
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2.2.3	 Application example for the wireless architecture
The example shows a building equipped with wireless 
luminaires and luminaires controlled via Wireless Group 
Control, connected to in total two Wireless Gateways. 
With each Wireless Gateway connected to an ethernet 
switch, the system saves considerably on control cabling 
and installer time.

When designing a system layout, keep the following 
guidelines in mind:

Location of the Wireless Gateway
The best location of the Wireless Gateway is in a high-
density grid, with as much nodes as possibles within 
reach, but at least more than two nodes in reach.

	 Note
The maximum distance is limited to the application, 
see the recommended maximum distances on the 
next page.

Ethernet switch

Wireless gateway

Wireless group border

DALI wiring

Ethernet wiring

Wireless luminaire

DALI luminaire

DALI extender / SR Bridge

max. 15 m

max. 
15 m

	 2.2	 Formats and application
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Maximum number of devices:
•	 Each Wireless Gateway can join a maximum of 200 

wireless nodes to its network.
•	 With Wireless Group Control:

•	 A SR bridge controls maximum 20 DALI 
luminaires, or up to 400 VA switching capacity.

•	 A DALI extender can connect to a maximum of 20 
luminaires.

Recommended maximum distances:
•	 Keep the cable length of each Wireless Gateway to 

the ethernet switch limited to 100 m (328 ft). 
•	 In open ceilings (for example in the sales floor or back 

of house, the distance (D1) between two wireless 
devices (luminaire or node) is maximum 15 m (49 ft). 
See figure 1.

•	 In closed ceilings (recessed luminaires or nodes, for 
example in offices) the distance (D1) between two 
nodes is maximum 10 m (33 ft). See figure 1.

•	 When installing in a corridor, use half the distance 
(D2) between two wireless devices to ensure that 
there will be always a second device (D1) in reach in 
case one of the devices fails. See figure 2.

	 2.2	 Formats and application

D1

D1

Figure 1. Application of wireless luminaires in an open space

Figure 2. Application of wireless luminaires in a corridor

D2

D1
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Channel selection
As each Wireless Gateway creates its own wireless 
network, it is important that these networks don’t 
interfere with each other. Zigbee uses the channels 11, 
15, 20 and 25.
•	 Avoid using channel 11 as it overlaps with Wi-Fi
•	 Usage of the channels 15, 20 and 25 is recommended, 

with a preference for the channels 20 and 25

The system offers easy identification of the wireless 
devices by using the Philips Dynalite Enabler app in 
combination with discovery by means of Bluetooth. 
These devices can be assigned to their respective area or 
zone in the app.

	 2.2	 Formats and application
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2.3	 Upgrade scenarios

Store Flex systems using the PDDEG-S Ethernet Gateway 
are upgradable to Multisite. Also, the other variants of 
the Dynalite for Retail are upgradable to Multisite.

Store Mini Kit/Store Kit

Rollout scenario

•	 Philips Dynalite controls
•	 Philips LED luminiaires
•	 Lighting design

Upgrade scenario

•	 Add or replace PDEG by PDDEG-S
•	 Controls design review
•	 Commissioning
•	 Request and activate licenses

Store Flex

Rollout scenario

•	 Philips Dynalite controls
•	 Philips LED luminiaires
•	 Lighting design
•	 Project management
•	 Controls design
•	 Commissioning

Upgrade scenario

•	 Add or replace PDEG by PDDEG-S  
(if not yet equipped with a PDDEG-S)

•	 Controls design review
•	 Commissioning
•	 Request and activate licenses

Multisite

Rollout scenario

•	 Philips Dynalite controls
•	 Philips LED luminiaires
•	 Lighting design
•	 Project management
•	 Controls design
•	 Commissioning
•	 License activation

Upgrade scenario
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The aim of the intake is to allow to tailor the solution 
exactly to the needs of the customer. What are his 
exact demands and how should the lighting system 
be engineered. For this it’s important to have some 
knowledge of the theory behind the system.

3.1	 System capabilities

The design of Store Flex projects is crucial since the 
allocation of the areas may be achieved by separating 
the physical channels, which can be done by means of 
wiring. The Store Flex system supports multiple types 
of control components, like DALI broadcast, DALI 
addressable, phase-cut dimming controllers, relay 
controllers, etcetera.

The Store Flex system can be tailored to all kinds of retail 
formats.
 

3.1.1	 Areas
Per retail format the areas are defined at a high level. 
Depending on the size of the format, it’s possible to 
define multiple areas. A maximum of three areas can be 
created, for example:
•	 Sales Floor
•	 Back of house
•	 Outdoor

3.1.2	 Zones and Channels
Per area you can identify up to 48 zones, for example on 
the Sales Floor: 
•	 Bakery
•	 Meat
•	 Cash registers
Etcetera

Each zone is represented as a logical channel, which can 
be either dimmable or switchable. To make sure that the 
name of the zone is visible in the Store Control UI, each 
channel should be given the same name as the zone it 
corresponds with. 
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3.1.3	 Scenes and Schedules
For each area you can create scenes:
•	 Indoor area:	 32 scenes
•	 Outdoor area:	 32 scenes (with day/night mode)

The system accommodates a maximum of 100 schedules 
of which up to five need to be reserved for standard 
configuration. The Ethernet Gateway takes care of the 
execution of the schedules. 

The schedules need to be aligned with the needs of the 
customer and configured before handover of the system 
and can be edited afterwards using the Store Control UI.

 

	 3.1	 System capabilities
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3.1.4	 Store Control UI
A preconfigured Store Control UI package is readily 
available for download on the MyLighting portal. 
Uploading of this package is done using System Builder.

The Store Control UI is a web-based interface that runs 
on a web browser installed on a device, independent if 
the device runs on Android, iOS or Windows, or on the 
dedicated PDTS touchscreen. The software recognizes 
the type of logical channel and adapts the user interface 
to it, showing a slider for dimmable channels and a 
switch button for a switchable channel.

	 3.1	 System capabilities
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3.2	 Users and user roles

Below an overview of the users and the user roles that 

that are involved in the rollout of a Store Flex project. 
Note that there’s a clear distinction between users 
handling offsite and onsite tasks.

3.2.1	 Users handling offsite tasks
Offsite tasks involve site preparation and design.

Lighting designer
The lighting designer uses the site layout/floor plan 
to create a lighting design, resulting in a reflected 
ceiling plan and luminaire count (bill of material for the 
luminaires).

Controls designer
The controls designer combines the information 
provided in the project template and the reflected 
ceiling plan using the System Builder Design Mode 
(System Designer). This is a powerful tool that provides 
a quick and orderly process for designing a Dynalite 
lighting control system.

	 Note
A technician license of System Builder is required 
before you can use System Designer. To request 
this license, in System Builder click Help and select 
License.

3.2.2	 Users handling onsite tasks
Onsite tasks like installation and commissioning typically 
require having someone present at the site.

Installer/site engineer
The designs require approval by the customer, after 
which the products will be ordered and delivered. When 
the site is ready for installation, the installer and/or the 
site engineer can start their activities.

Offsite tasks Onsite tasks
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3.3	 Intake and rollout

3.3.1	 Project template
All customer information as described in the previous 
sections is collected in the Project Template (also known 
as Intake Form, see the Project Template).
Each section corresponds with a step in the offsite 
preparation of the project execution.

The information in the project template regarding the 
lighting control zones, lighting plan and other control 
options is used to prepare the project for commissioning. 
See the section 4.3	  Prepare the System Builder job file.

Based on the project template, we prepare the digital 
twin of the lighting system upfront, simplifying the 
on-site commissioning effort so it can be done by your 
installer or a site engineer. 

 

3.3.2	 Off-site and on-site activities

Offsite preparation
Trained experts carry out the off-site preparation that 

consists of the following steps:
•	 Intake

•	 Complete project template and requirements 
document based on customer input and 
alignment

•	 System design
•	 Lighting design: creation of the reflected ceiling 

plan
•	 Controls design: creation of the customized 

project file
•	 Ordering

•	 Order products (lighting and controls)

	 Important
For projects that are configured with wireless 
controls, it’s important that the prepared project file 
is saved in the cloud using a Dynalite account. Contact 
your local Signify representative for requesting the 
account.

Offsite preparation Onsite installation
and commissioning

Intake System design Order
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Onsite installation
The installer and commissioning engineer take care of 

the on-site installation that consists of the following 
steps:
•	 Installation

•	 All lights and controls installed and functional
•	 Commissioning

•	 Downloading the latest device firmware versions 
from www.dynalite.com; 

•	 Commissioning of wired devices using System 
Builder

•	 Commissioning of wireless nodes using the Philips 
Dynalite Enabler app

•	 Download the UI-files from the MyLighting Portal
•	 Validation

•	 End-to-end validation of controls and lights
•	 Final project file

•	 Site delivery
•	 Ready to use
•	 Handover of the site to the customer 

3.3.3	 System Builder/System Designer
For the controls design, the experts use System Builder. A 
technician license of System Builder is required to enable 
System Designer. This is a powerful tool that provides 
a quick and orderly process for designing a Dynalite 
lighting control system.

Onsite, System Builder is used to deploy the prepared 
project file into the Dynet network.

Install Commission Validate Deliver

	 3.3	 Intake and rollout

http://www.dynalite.com
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4.1	 System design

The system design of a Store Flex project is different 
when compared to a standard Dynalite system. Store 
Flex is a simplified, easy to use system, providing full 
control to the customer. The system requires a design-in 
for the complete customer offer (luminaires + controls). 
Both lighting and controls design require a work order 
to be assigned to the person having the dedicated role 
that will carry out the task.

Lighting design Control design



30	 Chapter contents

04	 Offsite preparation

	 Main contents

4.1.1	 System characteristics
During design and commissioning of a Store Flex system, 
pay attention to the following system characteristics:
 1.	 The Store Flex system combines a modular Dynalite 

control topology with a user interface developed for 
a retail store. 

	 For Store Flex tested and verified load controllers, see 
section 4.1.3 Controls design.

2.	 When implementing wireless controls, additional 
supported components are added to the modular 
Dynalite control topology. Systems with wireless 
devices require additional attention during the 
design process. 

	 For tested and verified controllers, see sections  
4.1.4 Wireless controls design.

3.	 There are System Builder (SB) job file templates 
available for faster creation of a project specific job 
file. These templates include a basic configuration. 
The following templates are available:
•	 2 indoor areas, 1 outdoor area
•	 1 indoor area, 1 outdoor area
•	 3 indoor areas
•	 2 indoor areas
•	 1 indoor area

	

	 These job file templates are all available using 
a PDDEG-S as central store controller (preferred 
option), but also with a PDEG or PDTS as central store 
controller. For more information about the job file 
templates, see section 4.2 System Builder job file 
templates.

	 Important
Only the job files for use with a PDDEG-S are suitable 
for application in projects using wireless controls.

4.	 Pre-design of the project area configuration is crucial 
since the area allocation can only be achieved by 
separating the physical channels by means of wiring. 
The physical channels are mapped to the logical 
channels which can easily be renamed to the specific 
needs for these zones. For instance, Fresh food, 
Bakery, etcetera. These names are shown in the UI.

	 4.1	 System design
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4.1.2	 Lighting design
The specific requirements of the customer and the 
specifics of the site layout are considered when creating 
the lighting design, that results in the reflected ceiling 
plan and a luminaire count (lighting bill of materials).

Capturing the lighting design graphically in an 
(AutoCAD) drawing influences the speed and accuracy 
of the controls design.

Details of the lighting design can be provided in the 
project template.
 

4.1.3	 Controls design
While using System Designer, it generates:
•	 Bill of Materials (BoM)
•	 Project file
•	 Installation summary
•	 Wire diagram
•	 Load schedule report

Quantity of network devices
Theoretically, the RS-485 standard allows to connect an 
unlimited number of devices to a data cable. Practically, 
it’s recommended to limit the number of devices per 
gateway to 100.

In case the system requires higher numbers of devices on 
the gateway, this is possible. For more information, see 
the generic System Builder documentation.

	 4.1	 System design
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Power supply
Because several devices are powered over the network, 
the quantity of consuming devices such as panels and 
sensors need to be considered. Typically, most panels and 
sensors will run between 10 to 15 Vdc at 25 mA.

In case of a large number of consuming devices, a 
secondary power supply (DDNP1501) can be added to 
boost the overall network voltage. The DDNP1501 can 
supply 15 Vdc at 1.5 A.

In general, most Philips Dynalite load controllers 
generate approximately 100 mA to the Dynet network 
and will drive 4 or 5 consuming devices without the need 
for a secondary power supply. Refer to the product data 
sheets for calculation the power requirement for the 
Dynet communication bus.

Make sure to use Dynet-STP-CABLE-LSZH  
(or equivalent) cables.

	 4.1	 System design
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Tested and verified controllers for Wired
The specifications of each controller type limit the 
number of luminaires that can be connected. Refer 
to the product data sheets on www.dynalite.com for 
detailed information.

DDBC120-DALI
•	 Single DALI control output, supporting one full DALI 

universe of 64 addresses.
•	 One feed-through relay rated at 20 A (500 A surge) 

for switching power to the drivers.

DDBC320-DALI
•	 Three DALI outputs, allowing to control up to 192 

DALI devices.
•	 Three feed-through switched circuits rated at 20 A 

for DALI driver mains supply.

DDBC1200
•	 12 control outputs, selectable to DALI, 0-10 V/1-10 V 

or DSI output capacity.
	 In DALI Broadcast mode: 80 DALI drivers per channel, 

300 total. 

DDRC420FR
•	 Four switched feed-through outputs at 20 A 

(inductive), maximum device load 80 A

DDRC1220FR-GL
•	 12 switched feed-through outputs at 20 A (inductive), 

maximum device load 180 A

DDMIDC8
•	 Eight digital inputs, which can be individually 

configured as dry contact or 0-24 V AC/DC input
•	 Four 0-5/0-10 V analogue inputs

DDNG485
•	 Routes Dynet to third-party systems
•	 In DMX512 mode, capable of transmitting and 

receiving 512 DMX channels

	 4.1	 System design
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Tested and verified controllers for Wireless

PDZG-E Wireless Gateway
•	 Seamlessly integrates wireless lighting control using 

Zigbee PRO wireless communication
•	 Ensures stable and robust lighting control in busy 

environments by wireless mesh networking
•	 Connects to the wired control topology ensuring full 

compatibility

SNS441 IA wireless transceiver
•	 Operates with the established Xitanium SR driver 

standard
•	 Enables Wireless Group Control when connected to a 

Xitanium SR Bridge or a DALI Extender
 
Xitanium SR Bridge
•	 Controls up to 20 DALI drivers
•	 Capable of connecting multiple drivers with a load of 

up to 400 VA
•	 Switches the connected drivers fully off, no standby 

power
•	 Programmable via the SR interface or SimpleSet.

DALI Extender
•	 Controls up to 20 DALI drivers
•	 Supports emergency luminaires

	 Note
Currently, emergency lighting is not supported in the 
Store Flex system.

	 4.1	 System design
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4.1.4	 System wiring

Cable limits

Dynet cable length
•	 When using the Dynet STP Cat 5 cable, the number of 

Philips Dynalite devices is limited to 100.
•	 The maximum Cat5 cable length between the devices 

is 100 m.
•	 Any other cable used for RS-485 data transmission 

should be of the type STP with a characteristic 
impedance the twisted pair between 100 to 120 Ω.

•	 The maximum current a single gateway can draw is 
limited to 2 A.

 
 

DALI cable cross sections
The maximum voltage drop on the DALI bus is 2 V. 
Therefore, use cables with the specifications according 
to the table. DALI cables of over 300 m (1000 ft) are not 
allowed.

DALI conductor diameter

Length Cross section

≤ 100 m ≤ 330 ft 0.5 mm2 AWG 20

100 to 150 m 330 - 500 ft 0.75 mm2 AWG 18

150 to 300 m 500 - 1000 ft 1.5 mm2 AWG 16

	 4.1	 System design
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Ethernet cable length
The length of the Ethernet cables is limited to 100 meter 
per run.

Built-in dry contacts
The maximum distance to the input source depends on 
the type of connection and the device used to create the 
connection. See the specification sheets of the specific 
components for more details regarding maximum cable 
lengths etcetera.
 
Physical connection testing
The in-store controllers have manual override buttons, 
which will help the site engineer to confirm the correct 
physical power connection. Control protocol tests can 
only be performed with System Builder as a tool, or on 
the mobile device, by moving the sliders in the Scenes 
page for each channel. Refer to the respective product 
installation guides for correct test procedures.

	 4.1	 System design
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4.1.5 	 Customer supplied components

Wireless access point
The Wireless Access Point (AP) establishes the 
communication between the mobile device (for example 
the tablet) and the Store Control UI on the Ethernet 
Gateway. 

For this purpose, a consumer router shall be used. The 
minimal specifications are:
•	 Standards IEEE 802.3, IEEE 802.11g, IEEE 802.11b
•	 Ports:

•	 Internet: 10/100 RJ-45 Port
•	 LAN: 10/100 RJ-45 Switched 

•	 Firewall
•	 WEP/Wireless security Wi-Fi Protected Access™2 

(WPA2)

Configure the access point
•	 Give the AP a comprehensible network name (SSID)
•	 Select a security method and configure a strong 

password.

 

	 Note
•	 Store the SSID and password in the system 

documentation for future reference.
•	 It is advised to configure the Ethernet Gateway 

with a static IP address, for example 192.168.1.50.

Tablet
Tablets add flexibility to the user for easy control and
arrangement of project settings without depending on
static/dedicated devices. Simply open any browser on a
tablet device and access the Store Control UI via entering 
the IP address of the Ethernet Gateway. For easy access 
create a shortcut on the homepage of the tablet.

Recommended minimum requirements for a tablet are:

iOS Android

Version iPadOS 13 or newer Android 7.0 or newer

Screen resolution 1536 x 2048 800 x 1280

Web browser Recent version of Safari or Chrome

	 4.1	 System design
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4.2	 System Builder job file templates

The available System Builder job file templates facilitate 
and significantly speed up commissioning. 

There is a template available for each of the five 
corresponding scenarios, provided the system limitation 
of maximum three areas (A). These areas can be either all 
indoor, or a mix of indoor and outdoor areas.

Select the preferred template that best suits the project 
configuration. 

	 Note
•	 The table shows the template files available with 

the PDDEG-S. Identical templates are available 
with the PDEG or PDTS as store controller. Contact 
the Signify System Experts for more information.

•	 The outdoor area is by default configured as  
Area 4.

System Builder job file template name Description

StoreFlex_PDDEG-S_Template1_2IA_1OA 2 Indoor areas (A=2, A=3) 
+ 1 Outdoor area (A=4)

StoreFlex_PDDEG-S_Template1_1IA_1OA 1 Indoor area (A=2)  
+ 1 Outdoor area (A=4)

StoreFlex_PDDEG-S_Template1_3IA 3 Indoor areas  
(A=2, A=3, A=4)

StoreFlex_PDDEG-S_Template1_2IA 2 Indoor areas (A=2, A=3)

StoreFlex_PDDEG-S_Template1_1IA 1 Indoor area (A=2)
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•	 Each job file template includes the specified store 
controller with 100 schedules already prepared. 

•	 In templates including an outdoor area, the first two 
schedules are reserved for sunset and sunrise.

•	 In all templates, each area requires a reserved 
schedule as system default: three areas equal three 
reserved schedules (named Default #)

•	 All schedules named New Schedule # give the end-
user the possibility to create new schedules directly in 
the Store Control UI.

Area number and type

Indoor Outdoor Indoor Outdoor Indoor Indoor Indoor

A=2 A=3 A=4 A=2 A=4 A=2 A=3 A=4 A=2 A=3 A=2

1 Sunset Sunset Default 1 Default 1 Default 1

2 Sunrise Sunrise Default 2 Default 2 New Schedule 2

3 Default 3 Default 3 Default 3 New Schedule 3 New Schedule 3

4 Default 4 Default 4 New Schedule 4 New Schedule 4 New Schedule 4

5 Default 5 New Schedule 5 New Schedule 5 New Schedule 5 New Schedule 5

6 New Schedule 6 New Schedule 6 New Schedule 6 New Schedule 6 New Schedule 6

7 New Schedule 7 New Schedule 7 New Schedule 7 New Schedule 7 New Schedule 7

... ... ... ... ... ...

100 New Schedule 100 New Schedule 100 New Schedule 100 New Schedule 100 New Schedule 100

Template suffix

2IA_10A 1IA_10A 3IA 2IA 1IA

	 4.2	 System Builder job file templates
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4.3	 Prepare the System Builder job file

4.3.1	 How to design the system
In general, the System Designer feature in System Builder 
is used to design the system.

Benefits of using System Designer compared to classic 
System Builder:
•	 Standardized way of design and commissioning of a 

system
•	 Minimizing possible errors when following all steps 

in the wizard
•	 System Designer calculates the lengths of the DALI 

cables and shows a message if the cable is too long.
•	 System Designer keeps track of the load of the Dynet 

devices and shows a message if the load is too high, 
requiring an additional power supply.

•	 System Designer produces reports that summarize 
the total number and types of luminaires, controllers, 
and other devices, as well as the total cable length. 
This helps when creating a quote.

 

	 Note
You need a technician license before you can use the 
System Designer feature in System Builder. You need 
to raise a ticket to request such license; see section 
6.1.1 Ticketing system (C4CS) how to do that.

	 Tip
More information about using System Designer can 
be found in the User Guide. Click Help > User Guides 
and select the System Designer User Guide.

In this section we describe the steps to take using the 
System Designer feature when creating the offsite 
design of the system.



41	 Chapter contents

04	 Offsite preparation

	 Main contents

4.3.2	 Using System Designer
•	 Open the System Builder job file template that best 

suits your project and click the button Design Mode 
	 ( ) to start the System Designer feature.
•	 Use the buttons in the Window menu to switch 

between the  Properties Window and the  
Floor Plan Window.

•	 When following the steps of the Design Assistant, 
take care for the attention points below:
a.	 5. Define Scale: Use Enter Background Scale when 

you know the scale of the floor plan used.
	 Use Draw Background Scale to define the 

scale manually. You can do this for example by 
measuring the distance between doorposts or the 
bay width of the shelves.

b.	 7. Add Distribution Boards: Consider the expected 
cable lengths when finding a good position for 
the distribution board(s) on the floor plan.

c.	 10. Group Fixtures: Use Draw DALI Cable to 
connect the DALI controlled luminaires, both 
broadcast and addressable. Make sure to connect 
the created universes with the distribution board.

	 Use Draw Fixture Group for switchable 
luminaires.

	 4.3	 Prepare the System Builder job file
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	 Note
•	 Make sure not to exceed the maximum number of 

devices on a DALI universe.
•	 Make sure to add luminaires to the correct 

universe, either broadcast or addressable.

d.	 10. Group Fixtures: After drawing the DALI 
universes, a symbol ( ) shows that the DALI 
cable is not connected to a distribution board (or 
a controller).

	 Click Draw Line ( ) and select Draw DALI Cable 
to connect the universe to a distribution board (or 
a controller).

e.	 12. Draw Areas: Draw a maximum of three areas. 
Give the areas a descriptive name and the ID 
following the Project template.

	 Important
Always assign Area 4 to the Outdoor area.

	 4.3	 Prepare the System Builder job file
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f.	 13. Draw Dynet Cable: When drawing Dynet 
cables, also make sure to connect the cable to 
a distribution board. If controllers are added to 
the distribution board in step 15, the symbol ( ) 
disappears.

g.	 15. Select Hardware: Click Open Hardware Selector 
Window and in the left panel select a 

 	  Circuit or  Universe (added in step 7). 
	 Select the controller of choice to add to the 

distribution board.

	 Note
The selection of controllers depends on the type of 
universe. Universes spanning multiple areas must 
be assigned to a DALI addressable controller. For 
more information, see Appendix A3 - Configure DALI 
individual addressing.

	 4.3	 Prepare the System Builder job file
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h.	 15. Select Hardware: In the left panel, select a 
Circuit or DALI universe and assign it by drag and 
drop to the appropriate controller in the right 
panel.

i.	 15. Select Hardware: In the left panel, select all 
added devices (load controllers, sensors, user 
interfaces) one by one and click  Rename to 
give each device a unique name.

	 Important
Give each device (controller, sensor, user interface) a 
unique name, for example by adding a consecutive 
letter or number, or any other identification (for 
example: usage or location). The reports reflect the 
names to help you identify which physical channel is 
connected to which controller.

j.	 15. Select Hardware: Click Apply To Job. Click 
Yes to confirm. A message shows if any problem 
occurs.

	 4.3	 Prepare the System Builder job file
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Close System Designer
Before closing System Designer:
•	 Make sure the Fixtures Grouped indicator shows 

100%.
•	 Make sure there are no exclamation marks ( / ) 

showing.
•	 Follow the steps 16. Generate Reports and 
	 17. Produce Documentation.
•	 Click the button Design Mode ( ) to close the 

System Designer feature.

	 4.3	 Prepare the System Builder job file
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Figure 1. Possible result after using System Designer

	 4.3	 Prepare the System Builder job file



47	 Chapter contents

04	 Offsite preparation

	 Main contents

4.3.3	 Configure the job file
Once you added all devices to the project file, you can 
further configure the job file.

Create topology
1.	 Press Shift to multiselect the Load Controllers, and if 

applicable also the User Interfaces and Sensors.
2.	 Move the devices under the PDDEG-S. Click Yes to 

confirm.

	 4.3	 Prepare the System Builder job file
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Create logical channels (DALI broadcast)
1.	 In the Areas view, select the desired Area, for 

example Sales Area.
2.	 Click   Insert New Channel to create a new logical 

channel.
3.	 Create the logical channels according to the project 

template, with a maximum of 48. Give the channels a 
descriptive name that corresponds with the zone.

	 Important
Make sure to add a logical channel with the ID C1 in 
each area. 

4.	 Link each physical channel with its logical equivalent 
by means of drag and drop.

5.	 Repeat for all logical channels in areas using DALI 
broadcast.

2

4
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Prepare presets for the Indoor areas
The presets in System Builder enable the creation of 
Scenes in the Store Control UI.

Each System Builder job file template consists of 64 
presets for each indoor area. By default, eight of the 
presets will become visible in the user interface of the UI 
(marked in blue), where the hidden presets are prepared 
for use. 

1.	 In the Areas view, select an Indoor area (Area 2 or 3).
2.	 Change the name and the settings of each preset 

according to the Project template.
3.	 The customer can edit the names and settings after 

commissioning in the UI.
4.	 After commissioning, you can use the UI to make 

any of the hidden presets visible for usage in the 
interface. 

	 4.3	 Prepare the System Builder job file
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Prepare presets for the Outdoor area
The astronomical clock of the Ethernet Gateway allows 
for using the Day & Night Mode. The Day & Night Mode 
is available in the outdoor area only and is configured by 
using Preset offsets.

Each System Builder job file template including an 
outdoor area consists of four presets. If required, it is 
possible to add more presets:

1.	 In the Areas view, select the area Outdoor (A4).
2.	 Select the presets 5 to 8 and click Delete .
3.	 Add the day mode presets. You can add presets up to 

a total of 32.
4.	 Change the name and the settings of each preset 

according to the Project template.
5.	 Select all day modes presets and click  

Duplicate . Change the name of each duplicated  
night mode preset, making them all identical to the 
day mode presets.

6.	 Change the Type of the night mode presets to 
Hidden.

5

	 4.3	 Prepare the System Builder job file
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7.	 In the System view, select the Ethernet Gateway and 
click the tab Schedules.

8.	 Scroll down and select the schedule Sunrise.  
In the section Start Actions, click Edit Actions. Adjust 
the Offset to the total number of day presets, in this 
example: 6. Click Ok.

	 4.3	 Prepare the System Builder job file
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Configure inputs
All inputs, like sensors, user interfaces, dry contacts as 
well as some of the schedules, require specific Join byte 
configuration.

Make sure to configure all inputs with the correct Join 
byte:
1.	 Motion control on sensors

•	 Change the Join byte 81 (0x81)
2.	 Light control on sensors
	 (daylight harvesting)

•	 Change the Join byte to 82 (0x82)
3.	 User interfaces 
	 (like Antumbra, Revolution or third party dry 

contact):
•	 Change the Join byte to 83 (0x83)

4.	 Default schedules 
	 (except the Sunset and Sunrise schedule):

•	 Change the Join byte to 84 (0x84)
5.	 BMS automation, dry contacts 
	 (like Alarm/CCTV integration)

•	 Change the Join byte to 85 (0x85)

1

2

3

4

5
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Save job file
1.	 On the File menu, click Save As and select Save As 

Job File.
2.	 Store the job file at a logical location and give it a 

recognizable name.
3.	 Close the job file. You need it during onsite 

commissioning.

	 4.3	 Prepare the System Builder job file
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4.3.4	 Configure wireless in the job file
Follow the instructions below when configuring wireless 
luminaires.

Prepare the logical configuration
•	 Make sure to create upfront the necessary Areas and 

Channels.

	 Note
Adding wireless nodes is only possible when the areas 
and channels are predefined.

•	 Optionally, in Channel Properties, set the channel 
type to Zigbee.

•	 If already known, define the names and levels of the 
Presets.

	 4.3	 Prepare the System Builder job file
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Configure Site Gateway
1.	 In the System view, select the PDDEG-S.
2.	 On the Device menu, select Bridge Configuration 

Wizard.
3.	 On the Select Application Type page, change the 

following settings:
a.	 In System Selection, select Ethernet to Ethernet 

Translation Gateway.
b.	 In Ethernet Services:

•	 Select the Static IPv4 Address checkbox.
	 For dynamic IP addresses, see the note on the 

next page.
•	 Set the IP address to: 192.168.1.50
•	 Set the Gateway to: 192.168.1.1
•	 Set the Subnet mask to: 255.255.255.0
•	 Set the DNS server to: 192.168.1.1
•	 Select the Web Server checkbox

Click Next.

	 Note
When using an IP address in a different range, make 
sure that all IP addresses are in the same range, for 
example: 192.168.178.x.

3

a

b
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4.	 On the Configure Connections page, change the 
following settings:
•	 In Trunk Connection, select the Secure checkbox.
•	 In Ethernet Spur Connection, select the Secure 

checkbox.
•	 In case of adding Dynet devices (for example 

sensors), select in RS485 Spur the Enable RS-485 
Spur for Hybrid / Dynalite checkbox.

Click two times Next and click Finish.
5.	 Keeping the PDDEG-S selected: on the tab Ports, 

check if System Builder created the following ports:
•	 TCP Server secured port for Trunk
•	 TCP Server secured port for Spur

	 Note
Configuring the PDDEG-S Ethernet Gateway with a 
dynamic IPv4 address (DHCP) is also possible. In this 
case, the router or switch to which the PDDEG-S is 
connected should reserve a specific IP address for 
the MAC address of the PDDEG-S. Any details of this 
method are not described in this document.

4

5
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Add Wireless Gateways
1.	 In the System view, click  Insert Device from List.
2.	 Select the tab Network Devices.
3.	 Under Gateways – Wireless Gateway, double-click the 

PDZG-E.
4.	 The PDZG-E is added to the topology.
5.	 If required, repeat to add more PDZG-E Wireless 

Gateways.

Create topology
1.	 Press Shift to multiselect the PDZG-E Wireless 

Gateways.
2.	 Move the devices under the PDDEG-S. Click Yes to 

confirm.
3.	 For each PDZG-E Wireless Gateway: on the tab Ports, 

check if System Builder created a TCP Client secured 
port that points to the IP address of the PDDEG-S 
Ethernet Gateway, so traffic is automatically routed 
to the Ethernet Gateway.

	 4.3	 Prepare the System Builder job file
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Configure Wireless Gateways
1.	 In the System view, select a PDZG-E.
2.	 On the tab Device Properties, in the section Device 

Identification, give the device a unique name. 

	 Important
Give each PDZG-E a unique name, for example by 
adding a consecutive letter or number, or any other 
identification (for example: usage or location). This 
helps you identifying the correct Wireless Gateway 
when assigning the luminaires as the name also 
shows in the Philips Dynalite Enabler app.

3.	 Scroll down to the section ZigBee, select a ZigBee 
channel number.

	 Note
•	 Usage of the channel numbers 15, 20, 25 is 

recommended, of which channels 20 and 25 are 
preferred.

•	 In cases that there is a need of using identical 
channel numbers, always make sure that these 
channels don’t overlap each other in the physical 
space.

2
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4.	 On the tab Ports, in the section IPv4, set the Use static 
IP address either to:
•	 False

	 The gateway obtains a dynamic IP address from 
the PDDEG-S Ethernet Gateway, no additional 
configuration required.
•	 True

	 Configure the static IP and network settings manually 
using the steps below.

5.	 When configuring a static IP address, manually set:
•	 IP address: consecutive in the same range as the 

Site Gateway (for example: 192.168.1.101 for 
Wireless Gateway 1, 192.168.1.102 for Wireless 
Gateway 2, etcetera)

•	 Gateway: 192.168.1.1
•	 Subnet mask: 255.255.255.0
•	 DNS server: 	 192.168.1.1

6.	 Repeat for the other PDZG-E Wireless Gateways.

5
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4.3.5	 Save job file to the cloud (wireless only)
Once the preparation of the job file for wireless is 
finished, it needs to be uploaded to the cloud to make it 
available for onsite commissioning.

Login to the cloud
1.	 On the Tools menu, click Interact Accounts.
2.	 Click  Add and select Dynalite Cloud Account.
3.	 For the first time, select:

•	 Environment: Production
•	 Region: Global
•	 Email ID: the registered email address 

	 Click OK.
4.	 Select your account to login to. If required, fill in your 

password.

	 Note
•	 Your user account must be registered before you 

can login to your Interact Account. This account 
can be requested via sme.interact-lighting.com. 

•	 The status bar at the bottom shows your 
connection status and the region you’re 
connected to.

	 4.3	 Prepare the System Builder job file
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Save job file
1.	 On the File menu, click Save As and select Save Job 

To Cloud.
2.	 If applicable, select the Organization. 
3.	 Provide a File Name and optionally a Description. Click 

Save.

	 Important
Saving the job file to the cloud is only applicable for 
projects that are configured with wireless controls.

	 4.3	 Prepare the System Builder job file
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Account management
The person who saves the project to the cloud is the 
project owner. Only project owners can provide other 
Interact accounts access to the project using the Philips 
Dynalite Cloud Platform.

1.	 Open the webpage dynalite.interact-lighting.com 
and login with your credentials.

2.	 In the project list, select your project.
3.	 In the tab Users, click Add user.
4.	 Provide the email address and select a role:

•	 Viewer: user has read only access
•	 User: user has write access
•	 Owner: user is project owner and will be able to 

add other users

	 Important
Added users must have an Interact account.  
This account can be requested via  
sme.interact-lighting.com.

	 Note
For commissioning activities with the Philips Dynalite 
Enabler app, minimum User rights are necessary.

	 4.3	 Prepare the System Builder job file
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4.4	 Plan installation and commissioning

4.4.1	 Order hardware
In System Designer, following step 16. Generate Reports 
and 17. Produce Documentation you created the files 
that provide you an overview of the hardware to order. 
In the Project Template, search for the Bill of Materials 
(BoM) for both controls and luminaires. Filling in these 
pages helps you to process the ordering of the hardware.

 

4.4.2	 Prepare commissioning
Before starting with commissioning, make sure:
•	 that a DTK622USB PC node and ethernet cable are 

available;

	 Note
Use a computer with Windows 10 installed on it to 
connect via the PC node.

•	 to have a computer with the latest version of System 
Builder installed on it;

•	 to download the latest firmware of the controllers 
from www.dynalite.com;

•	 when using the PDEG Ethernet Gateway as central 
store controller: to download the firmware package 
with version 3v54b3 from the MyLighting portal;

•	 to download the Store Control UI packages from the 
MyLighting portal;

•	 to agree with the IT department of the customer on 
the IP address of the Wireless Access Point.

http://www.dynalite.com


64	 Chapter contents

04	 Offsite preparation

	 Main contents 	 4.4	 Plan installation and commissioning

4.4.3	 Install Philips Dynalite Enabler app

	 Important
Installing the Philips Dynalite Enabler App is only 
required for projects that are configured with 
wireless controls.

Before going onsite, install the Philips Dynalite Enabler 
app on your phone. The app is used to: 
•	 Discover the wireless luminaires via Bluetooth, 
•	 Assign the wireless luminaires to the correct Wireless 

Gateway
•	 Test the wireless communication of the wireless 

network

Download the Philips Dynalite Site Enabler 
app
The Site Enabler app is supported on Android 
and iOS.

•	 For Android, go to the Play Store. Search for ‘dynalite 
enabler’, select and install it.

•	 For iOS, go to the App Store. Search for ‘dynalite 
enabler’, select and install it.
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Login to the app
It’s recommended that the commissioning engineer 
checks upfront if the Site Enabler app functions as 
expected and prepares for the onsite commissioning. 

1.	 Open the app on your device. For the first time, select 
the checkbox to agree with the Terms of Software 
Service.

2.	 Select your region: Global
3.	 Select the system you want to commission: Dynalite. 
4.	 Enter your username (email address). Tap Next.
5.	 Enter your password. Tap Sign in.
6.	 Select the project to commission.

	 Note
•	 An active internet connection is required to 

synchronize between the Philips Dynalite Enabler 
app and the Dynalite cloud.

•	 At least you need to be registered as User to the 
project. Contact the project owner to create an 
account with sufficient access rights.

•	 Use the same account details to login to the 
Dynalite cloud in System Builder.

	 4.4	 Plan installation and commissioning
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Before you start with the onsite activities, make sure to 
complete to plan the installation and commissioning 
well in advance. See the sections 4.4 Plan installation and 
commissioning for more information.

This chapter describes the onsite commissioning of a 
system in the following situations:
•	 Wired commissioning, for projects with wired 

luminaires only. See section 5.2 Wired commissioning.
•	 Wireless commissioning, for projects with wireless 

luminaires, and hybrid projects with wired luminaires 
too. See section 5.3 Wireless commissioning.

Onsite activities consist of the following:
•	 Installation and wiring of the luminaires, including 

for example power and DALI, following the local 
guidelines and directives.

•	 Installation and wiring of the Dynalite network 
controllers, including sensors and user interfaces, 
according to the documentation produced during 
the offsite preparation.

•	 Additional commissioning of the controllers, 
assigning the luminaires to the correct areas, zones, 
and logical channels.

•	 If applicable, installation and setup of the Wireless 
Access Point for use 
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5.1	 Prerequisites

Before starting with commissioning, make sure that the 
following steps are completed:
•	 Luminaires installed, wired, and powered ON
•	 Controllers are installed in the distribution board, 

wired (both power and Dynet) according to the 
corresponding installation instruction and powered 
ON.

•	 Sensors and user interfaces are installed and 
wired according to the corresponding installation 
instructions.

•	 Basic checks have been performed to make sure the 
controllers are wired correctly.

•	 A DTK-622USB PC node is available.
•	 The recommended version of System Builder is 

installed on the PC of the commissioning engineer, 
and the Technical license is enabled.

	 Important
For the recommended version of System Builder, see 
the System Release Notes.

•	 The latest firmware of the Site Gateway is 
downloaded from the Signify Partner Portal.

•	 For projects configured for wireless: The Site Enabler 
app is installed on the phone of the commissioning 
engineer. See section 4.4.3 Install Philips Dynalite Site 
Enabler app.



69	 Chapter contents

05	 Onsite commissioning

	 Main contents

5.2	  Wired commissioning

	 Important
•	 See appendix A3 -  Configure DALI individual 

addressing how to configure DALI individual 
addressing.

•	 See appendix A4 - Configure DMX for RGB 
lighting how to configure DMX for RGB lighting.

5.2.1	 Discover devices
1.	 Open the job file of the project that you prepared 

during the offsite preparation.
2.	 Connect the PC to the Dynet using the DTK622USB 

PC node.
3.	 Use the sign-on button on each device to discover all 

devices.
	 Or: On the Insert menu, click Devices from Network. 
	 Click Discover Network and assign the discovered 

devices to the project.
4.	 Press Shift to multiselect all devices and press F12. 

Select Resave all device data and click OK.

3

4
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5.2.2	 Upgrade firmware

	 Important
Don’t upgrade the Ethernet Gateway, this will be 
done later during the commissioning process.

1.	 In the System view, select the devices in the list one 
by one.

2.	 Right-click the device and select Firmware Upgrade.
3.	 Select the previously downloaded and extracted uu-

file that corresponds to the device (see section 4.4.2 
Prepare commissioning). Click OK.

4.	 Wait until the process is finished.
5.	 Right-click the device, click Save To Device and select 

Save modified device data. Click OK.

	 Note
The firmware upgrade procedure can take up to 30 
minutes per device.

3
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5.2.3	 Configure the Ethernet Gateway

Set location and time zone
The Ethernet Gateway requires to run on the correct 
time and location information.

1.	 In the System view, right-click the Ethernet Gateway 
and select Set Realtime Clock.

2.	 Select the option Synchronize with PC Time. Click 
Apply and Close.

3.	 Again, right-click the Ethernet Gateway and select 
Set Location and Timezone.

4.	 Select the correct Country and City.
	 Or: select the Time Zone that corresponds with the 

location of install.

	 Note
You can also set or change the location and time zone 
with the Store Control UI.

2
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Add users
To create access to the login screen of the Store Control 
UI, there are two users defined with different access 
rights.

Add Store Manager
1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Users. 
3.	 Select the user Store Manager and create a password 

for this user. Confirm the password.

	 Important
•	 Create a password consisting of capital and 

lowercase letters, numbers and special characters 
with a minimum length of 10 characters, for 
example Vu@95dGk!0

•	 Make sure that you remember the password and 
store it at a safe place. You need it to login to  
the UI.

3
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Add Store Staff
1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Users. 
3.	 Select the user Store Staff and create a password for 

this user. Confirm the password.

	 Important
•	 Create a password consisting of capital and 

lowercase letters, numbers and special characters 
with a minimum length of 10 characters, for 
example Xa%83HKn?4

•	 Make sure that you remember the password and 
store it at a safe place. You need it to login to the 
UI.

4.	 Check if the setting User Management Write is set to 
Disabled.

3
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Connect to the Wireless Access Point

	 Note
•	 When using the PDTS, you can skip this procedure, 

but make sure to fill in all details in the Device 
Properties tab.

•	 In this document, the Wireless Access Point is 
configured with the IP address 192.168.1.50.

1.	 In the System view, right-click the Ethernet Gateway 
and select Bridge Configuration Wizard.

2.	 Select Dynet Ethernet Access Point and complete the 
following settings before you click Next:
a.	 Select the Connections checkbox.
b.	 Select the Static IPv4 Address checkbox.
c.	 Enter the agreed IP address, in this example 

192.168.1.50.
d.	 Enter the router subnet mask, for example 

255.255.255.0.
e.	 Select the Web Server checkbox and select HTTPS.

3.	 Click Next and Finish to close the wizard.

	 Tip
In case the HTTPS option is not available, clear the Web 
Server checkbox and select it again.

2

a b

d
c

e

	 5.2	 Prepare commissioning



75	 Chapter contents

05	 Onsite commissioning

	 Main contents

Configure Metrics
Metrics enable the device status feedback in the Store 
Control UI.

1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Metrics.
3.	 Click New and complete the following settings:

•	 Port type:		  Comm Port
•	 Polling interval:	 00:00:30

4.	 Right-click the device, click Save To Device and select 
Save modified device data. Click OK.

3
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Configure connection settings

1.	 In the System view, select the project name given to 
the job file.

2.	 Select the tab Connection Settings.
3.	 Select Use Ethernet Trunk Connection and click Yes 

to reconnect.
4.	 Check the connection status in the lower-right 

corner.
5.	 Save the job file.

3
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Check the firmware version of the Ethernet Gateway

1.	 Check the firmware version of the Ethernet Gateway 
with the recommended firmware version on the 
MyLighting portal. 

2.	 If necessary, load the correct firmware version 
following the instructions that can be found on the 
MyLighting portal.

5.3	 Wireless commissioning

	 Note
The procedures in this section are applicable for 
projects that are configured for wireless and can also 
be used for hybrid projects (consisting of wired and 
wireless controllers)

5.3.1	 Commission using the System Enabler app

	 Important
Always make sure to synchronize the data of the 
commissioned project. Don’t uninstall the app or 
change the project as this will prevent synchronizing.

	 Tip
In case that there is no internet connection available 
in the building, start the app outside of the building 
and open the project, then go inside and commission 
the project, and then synchronize the data outside of 
the building.
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Setup internet connectivity
1.	 Login to the app and select the project.
2.	 Tap Establish connectivity. Select Use available 

internet connection.
3.	 The system checks the internet connection.
4.	 Tap Done.

	 5.3	 Configure the Ethernet Gateway
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Add lights
1.	 In the app, tap Area commissioning.
2.	 Select an Area and a Channel to commission.

	 Important
Don’t use the area called Unassigned Area for 
commissioning.

	 Note
In case the app asks permission to use Bluetooth, tap 
Allow.

3.	 Tap Add lights.
4.	 Using the light plan, select the Wireless network to 

add the light to. Tap Select.
	 The app uses Bluetooth to scan for lights nearby. A 

list with lights that are found shows.

	 Note
Each wireless network corresponds with a Wireless 
Gateway.

	 5.3	 Configure the Ethernet Gateway
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5.	  Tap the luminaire icon to blink the light. This helps 
with identification of the lights.

	 Note
Write down on the light plan the id that belongs to 
the specific light.

6.	 If the blinked light belongs to the channel, tap Add.
7.	 Repeat for all lights in the channel. Tap Done if all 

lights are added to the channel.

	 5.3	 Configure the Ethernet Gateway
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Reset lights

	 Note
Sometimes lights may already be assigned to a 
wireless network. In this case a reset of the lights is 
necessary.

1.	 In case not all lights can be found, tap I cannot find 
all lights.

2.	 Follow the explanation and tap Retry.
3.	 If the problem persists, tap I cannot find all lights and 

then I still cannot find all lights.
4.	 Tap the luminaire icon to blink the light. When you 

find a light that belongs to the channel that you are 
editing, tap Reset.

5.	 Add the light to the channel following the previous 
procedure.

	 5.3	 Configure the Ethernet Gateway
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Test channel
1.	 After finishing adding lights to a channel, tap Test 

channel.
2.	 Tap the button ON/OFF to turn on or off the lights. 

Check if the lights corresponding to the channel 
respond as expected.

	 Note
•	 It takes some time before the button becomes 

responsive.
•	 The button shows the state of the lights in the 

channel: Red is ON, grey is OFF.

3.	 When ready, tap Done.
4.	 Proceed with a next channel to add lights to.

	 5.3	 Configure the Ethernet Gateway
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Test Area
1.	 After finishing all channels, select the area.
2.	 Tap Test area.
3.	 Tap the button ON/OFF to turn on or off the lights. 

Check if the lights corresponding to the channel 
respond as expected.

	 Note
•	 It takes some time before the button becomes 

responsive.
•	 The button shows the state of the lights in the 

channel: Red is ON, grey is OFF.

4.	 When ready, tap Next. Select the status of the area.
5.	 Optionally, it’s possible to add a note the status of the 

area.

Repeat the procedure in this section for the other areas 
and wireless networks.

	 5.3	 Configure the Ethernet Gateway
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5.3.2	 Retrieve job file

Login to the cloud
1.	 Connect the PC to the internet and run the 

recommended version of System Builder.
2.	 On the Tools menu, click Interact Accounts. Check if 

you are logged in to Caretaker.

	 Note
•	 Your user account must be registered before you 

can login to the Caretaker Account. See section  
4.3.5 Save job file to the cloud (wireless only).

•	 The status bar at the bottom shows your 
connection status and the region you’re 
connected to.

	 5.3	 Configure the Ethernet Gateway
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Download job file
1.	 On the File menu, click Open and select Open Job 

From Cloud.
2.	 If applicable, select the Organization. 
3.	 Select the name of the job file to open. Click Open.
4.	 Check if a green padlock shows next to the project 

name.

	 5.3	 Configure the Ethernet Gateway
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5.3.3	 Discover devices

	 Note
Make sure to connect the PC to the Dynet using a 
DTK622USB PC node.

General
1.	 Use the sign-on button on each device to discover all 

devices.
	 Or: On the Insert menu, click Devices from Network. 

Click Discover Network and assign the discovered 
devices to the project.

2.	 Press Shift to multiselect all devices and press F12. 
Select Resave all device data and click OK.

2
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5.3.4	 Upgrade firmware

1.	 In the System view, select the devices in the list one 
by one.

2.	 Right-click the device and select Firmware Upgrade.
3.	 Select the previously downloaded and extracted uu 

file that corresponds to the device (see section  
4.4.2 Prepare commissioning). Click OK.

4.	 Wait until the process is finished.
5.	 Right-click the device, click Save To Device and select 

Save modified device data. Click OK. 

	 Note
The firmware upgrade procedure can take up to 30 
minutes per device.

6.	 On the File menu, click Save As and select Save Job 
To Cloud to keep the job file updated.

	 Note
•	 Check if any luminaire that has been added using 

the Enabler app appears under its associated 
PDZG-E Wireless Gateway.

•	 No luminaires added yet? Then proceed with 
securing the Ethernet devices. See section  
5.3.5 Secure the Ethernet devices.
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5.3.5	 Secure the Ethernet devices

Apply security certificates
1.	 In the System view, right-click the PDDEG-S and 

select Manage Certificate.
2.	 In Select Certificate Type, select Device Site Certificate 

for TLS Connections.
3.	 Click Create and Upload and click Close.
4.	 Repeat also for all PDZG-E devices in the project.
5.	 Check if all devices now show a green padlock.
6.	 On the File menu, click Save As and select Save Job 

To Cloud to keep the job file updated.

2
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Change connection setting
1.	 In the System view, select the PDDEG-S.
2.	 On the tab Connection Settings, under the option 

Use Ethernet Trunk Connection, select TCP TLC.
3.	 On the File menu, click Save As and select Save Job 

To Cloud to keep the job file updated.

�
6
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Secure Ethernet connections
1.	 In the System view, select a PDZG-E.
2.	 On the tab Routing, make sure that the unsecured 

port 50000 is replaced by the secured port 50443.
3.	 On the tab Ports, make sure to delete port 50000 to 

avoid any unsecured connection.
4.	 Repeat for all PDZG-E Wireless Gateways in the 

project.
5.	 In the System view, select a PDDEG-S.
6.	 On the tab Ports, make sure to delete all unsecure 

ports:
•	 Port 50000 
•	 Port UDP

7.	 Repeat for all PDDEG-S Ethernet Gateways in the 
project (if any).

8.	 Press Shift to multiselect all devices and press F12. 
Select Resave all device data and click OK.

9.	 On the File menu, click Save As and select Save Job 
To Cloud to keep the job file updated.

2
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5.3.6	 Configure the Ethernet Gateway

Set location and time zone
The Ethernet Gateway requires to run on the correct 
time and location information.

1.	 In the System view, right-click the Ethernet Gateway 
and select Set Realtime Clock.

2.	 Select the option Synchronize with PC Time. Click 
Apply and Close.

3.	 Again, right-click the Ethernet Gateway and select 
Set Location and Timezone.

4.	 Select the correct Country and City.
	 Or: select the Time Zone that corresponds with the 

location of install.

	 Note
You can also set or change the location and time zone 
with the Store Control UI.

2
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Add users
To create access to the login screen of the Store Control 
UI, there are two users defined with different access 
rights.

Add Store Manager
1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Users. 
3.	 Select the user Store Manager and create a password 

for this user. Confirm the password.

	 Important
•	 Create a password consisting of capital and 

lowercase letters, numbers and special characters 
with a minimum length of 10 characters, for 
example Vu@95dGk!0

•	 Make sure that you remember the password and 
store it at a safe place. You need it to login to  
the UI.

3
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Add Store Staff
1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Users. 
3.	 Select the user Store Staff and create a password for 

this user. Confirm the password.

	 Important
•	 Create a password consisting of capital and 

lowercase letters, numbers and special characters 
with a minimum length of 10 characters, for 
example Xa%83HKn?4

•	 Make sure that you remember the password and 
store it at a safe place. You need it to login to the 
UI.

4.	 Check if the setting User Management Write is set to 
Disabled.

3
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Configure Metrics
Metrics enable the device status feedback in the Store 
Control UI.

1.	 In the System view, select the Ethernet Gateway.
2.	 Select the tab Metrics.
3.	 Click New and complete the following settings:

•	 Port type:		  Comm Port
•	 Polling interval:	 00:00:30

4.	 Right-click the device, click Save To Device and select 
Save modified device data. Click OK.

3
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Configure connection settings
1.	 In the System view, select the project name given to 

the job file.
2.	 Select the tab Connection Settings.
3.	 Select Use Ethernet Trunk Connection and click Yes 

to reconnect.
4.	 Check the connection status in the lower-right 

corner.
5.	 Save the job file.

3
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5.3.7	 Verify the wireless system
After completing all steps, including adding the wireless 
luminaires, you can proceed with system verification:

1.	 In the System view, select a PDZG-E.
2.	 On the tab Device Diagnostics, check if all added 

luminaires apprear.

	 Note
Loading this tab may take several minutes.

3.	 Check for each luminaire if the scenes (maximum of 
64) are synchronized.

4.	 Send Preset messages to the luminaires and check if 
everything is working accordingly.

5.	 Repeat for all PDZG-E Wireless Gateways in the 
project.

	 5.3	 Configure the Ethernet Gateway
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5.4	 Install and configure the Store Control UI

5.4.1	 Download the Store Control UI

1.	 Login to the Signify MyLighting portal.
2.	 On the Dashboard, click HTML technical documents 

and open the pages for Store Flex.
3.	 Download the package with the web-UI that 

corresponds with the gateway that you configured.

5.4.2	 Configure the Outdoor Area

1.	 In a file explorer, find the zip-file containing the web 
UI and unpack it.

2.	 Double-click the file and open config.jsn with 
Notepad.

3.	 Change the parameter outdoor if necessary:
a.	 Outdoor area configured:		 4
b.	 No outdoor area configured:	 null

4.	 Save and close the file.

	 Note
The outdoor area is by default configured as Area 4.

3
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5.4.3	 Load the Store Control UI
1.	 In the System view, right-click the Ethernet Gateway 

and select Upload Custom Web Pages.
2.	 Click Select a folder containing web pages and click 

OK.
3.	 Find the folder containing the web-UI files.
4.	 Select the Delete existing pages checkbox and click 

Close.

	 Note
The upload of the web-Ui files takes up to a few 
minutes.

2
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5.4.4 Load configuration
Loading the configuration to the Ethernet Gateway links 
the logical configuration with the device list.

1.	 In the System view, right-click the Ethernet Gateway, 
click Upload Configuration and select Upload All.

2.	 Wait until the message Successfully uploaded all XML 
files appears. Click Accept.

1
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5.5	 Create and install certificate

	 Note
•	 The procedures in this section are applicable for 

installations with an Ethernet Gateway only.
•	 In this document, the Wireless Access Point is 

configured with the IP address 192.168.1.50.

5.5.1	 Create certificate
1.	 In the System view, right-click the Ethernet Gateway 

and select Manage Certificate.
2.	 In the section Select Certificate Type, select System 

Builder certificate.
3.	 Enter the gateway details and location information. 

Make sure to fill in the correct IP address at Common 
Name (CN), in this example 192.168.1.50.

4.	 Click Create and Upload.
	 Wait two minutes for the system to create a signed 

certificate on the gateway.
5.	 After successful upload of the certificate, a message 

appears. Click Yes to proceed and click Close to close 
the dialog.

5
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5.5.2 Install certificate
A certificate is required to enable a secure connection 
between the operating device (for example a tablet) and 
the gateway. When you use a device for the first time, 
while accessing the user interface the warning message 
Your connection is not private, or similar, shows up.

Download certificate

	 Note
This instruction is written using a Chromium-based 
browser, like Google Chrome. 

1.	 In the web-browser, go to  
https://192.168.1.50/Signify.cer.

2.	 If the message Your connection is not private appears, 
click Advanced.

3.	 Click/Tap Proceed to 192.168.1.50 (unsafe).
	 The certificate is downloaded to the device.

	 Note
When you have the option to Open the file, ignore 
and close the message.

	 5.5	 Create and install certificate
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Install certificate on a device running iOS

	 Note
The steps in this section are intended for iOS 12.

1.	 In the device Settings, select Profile Downloaded.
2.	 Select Signify Dynalite System Builder. Tap Install.
3.	 A warning appears, tap Install.
4.	 A popup appears to confirm, tap Install.
5.	 Tap Done.
6.	 Clear the browser cache and close the web browser.

	 5.5	 Create and install certificate
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Install certificate on a device running Android

	 Note
The steps in this section are intended for Android 9 
and up and may be brand specific. Other versions of 
Android may use slightly different steps.

1.	 In the device Settings, tap Security > Other security 
settings.

2.	 Find Credential storage and tap Install from device 
storage.

3.	 Select the file signify.cer and tap Done.
4.	 Enter your Screen Lock (for example a pattern or PIN-

code). Tap OK.

	 Note
When a Screen Lock is not defined, you are asked to 
set one up. Without a Screen Lock, it’s not possible 
install the certificate.

5.	 Give the certificate the name Signify.
6.	 Under Used for, select VPN and apps. Tap OK.
7.	 A message that the installation was successful 

appears.
8.	 Clear the browser cache and close the web browser.
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Install certificate on a PC running Windows

	 Note
The steps in this section are intended for  
Windows 10.

1.	 Find the certificate in the file system.
2.	 Double-click the certificate to start installation.  

Click Open.
3.	 Click Install Certificate.
4.	 In the Certificate Import Wizard:

•	 Select Current User. Click Next.
•	 Select Place all certificates in the following store. 

Click Browse.
•	 Select Trusted Root Certification Authorities. 

Click OK.
•	 Click Next, then click Finish.

5.	 A Security Warning appears. Click Yes.
6.	 A message that the import was successful appears. 

Click OK.
7.	 Click OK to close the Certificate popup.
8.	 Clear the browser cache and close the web browser.

	 5.5	 Create and install certificate
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5.5.3	 Check secure connection of the UI
1.	 Open the web-browser and go to 

https://192.168.1.50/. Login to the system.
2.	 Check if the address-bar shows closed padlock. 

You can click the padlock to see the details of the 
connection and certificate.

	 5.5	 Create and install certificate
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5.6	 Verification and handover

	 Note
The User Guide for Store Control UI shows the usage 
of the UI for both store staff and store managers. 
This document is available via the Signify MyLighting 
portal.

5.6.1	 Verify the installation
The Store Control UI supports 
1.	 Check if it is possible to login as:

•	 Store Manager
•	 Store Staff

	 Use the password configured during the offsite 
commissioning. See 4.3.3 Configure the job file.

2.	 Create or edit scenes according to the customer 
needs. Apply the scenes to regular day to avoid 
triggering preset 1 at midnight.

3.	 Check the system status and make sure all zones are 
operational.
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4.	 In the settings, configure according to customer 
preferences:
•	 Language
•	 Hour format
•	 First day of the week

5.	 Make sure that Date and time and Location are 
set correctly to be sure that the Astro clock works 
accordingly.

6.	 Provide a copy of the latest User Guide to the 
customer. 

7.	 Using the user guide, train the customer on the usage 
of the system.

	 5.6	 Verification and handover

www.interact-lighting.com

User Guide

Store Control UI
Release 1.7.1

Lighting control with Store Kit and 
Store Flex for medium and large 
sized stores
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5.6.2	 Set the operation mode
The Store Flex system supports inputs from a Building 
Management System (BMS). In case a BMS is used, it’s 
necessary to disable the Scheduling Mode in the Store 
Control UI.

1.	 Login to the Store Control UI and open the Settings 
page.

2.	 Find the Scheduling Disable option and toggle the 
switch to disable.

With the schedules disabled, the system is intended to be 
controller by a third party BMS.

2

	 5.6	 Verification and handover
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6.1	 Technical support

6.1.1	 Ticketing system (C4CS)

Personnel of Signify
Follow the Learning Path Systems Support ticketing in 
C4CS. The Learning Path explains how to submit a
ticket. Markets and System Centers to create a Business 
Support Request ticket (BSR) providing the necessary 
detail, including specified architecture and owner.

Personnel of Customer System Integrators (CSIs)
1.	 Login to the Signify MyLighting portal.
2.	 Click on Technical support.
3.	 Search the knowledge base for any information on 

the subject you want help for.
4.	 If you don’t find relevant information, click Request 

Support at the bottom of the search result.
5.	 Fill in the webform adding all mandatory details 

required to support you.
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A1	 Configure DALI individual addressing

	 Note
•	 Applicable for all DALI addressable controllers, 

like the DDBC120-DALI and DDBC320-DALI.
•	 First finish firmware upgrades of all controllers.

1.	 In the System view, select a load controller. 
2.	 Select the Outputs tab and click Enumerate Ballasts.
	 Discovered luminaires receive a Number and a green 

icon with the status Known.
3.	 Select the Flash checkbox to flash each discovered 

physical channel to validate the location.
	 Or: use the tool Localize by Search.
4.	 Assign the physical channel to the corresponding 

logical channel on the floorplan. 
5.	 Upload the logical configuration to the Ethernet 

Gateway every time after making changes to it. 
Only then the changes will be reflected in the Store 
Control UI. See section 5.4.4 Load configuration.

1

3
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A2	 Configure DMX for RGB lighting

Store Flex supports the use of RGB lighting to enhance 
the experience of the shopper in the store.

A2.1	 Setup DDNG485

1.	 In the System view, select the DDNG485.
2.	 Right-click the device and select Factory Set. Select 

DDNG485-DMX-Tx and click OK. Wait until the 
process is finished.

	 Note 
The factory reset procedure can take several minutes 
per device.

3.	 Right-click the device and select Firmware Upgrade. 
Select the extracted uu-file corresponding to the 
device. Click OK. Wait until the process is finished. 

4.	 Move the device under the Ethernet Gateway. Click 
Yes to confirm.

5.	 Right-click the device and select Save To Device. 
Select Save modified data and click OK.

2



Appendix A – Additional commissioning

113	 Chapter contents	 Main contents

A2.2	 Setup RGB lighting

1.	 In the Areas view, select the area where RGB lighting 
is installed.

2.	 Click Insert New Channel three times. Rename the 
channels.

	 Important 
Three logical channels are required to control red, 
green and blue. Make sure to give the channels the 
exact same name.

3.	 Select the Unassigned Devices tab. Expand the 
Gateways tree and find the unassigned Physical 
Channels. Drag Physical Channel 1 to the first created 
Logical Channel.

4.	 Select the first Logical Channel. Select the tab 
Channel Properties and find the parameter Type. 
Select the type Red.

5.	 Repeat the previous steps for the second and third 
channel. Select respectively the type Green and Blue.

6.	 Right-click the device and select Save To Device. 
Select Save modified data and click OK.

7.	 Upload the logical configuration to the Ethernet 
Gateway. See section 5.3.6 Load configuration.

2

4

	 A2	 Configure DMX for RGB lighting
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B1	 Lighting network components

PDDEG-S or PDEG Ethernet Gateway
The Philips Dynalite PDDEG-S provides gateway services 
between Ethernet and Dynet devices, enabling secure 
online access to the Philips lighting control system.

The gateway enables lighting control via the Store 
Control UI, access to the timeclock and schedule editor 
functions. It provides bridging functionality between the 
Ethernet backbone and the Dynet fieldbus devices.

	 Important
•	 The PDEG Ethernet Gateway is not compatible 

when planning to upgrade to Architecture  
FLX Multisite.

•	 Usage of BACnet, also a requires a PDDEG-S as 
central store controller.

	 Note
The PDEG Ethernet Gateway requires power from the 
Dynet network or a DDNP1501 power supply.
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PDZG-E Wireless Gateway
The Philips Dynalite ZigBee Gateway Ethernet is a 
wireless communication hub that connects wireless 
nodes (luminaires or wireless group controllers) to 
the Dynalite lighting control system via an Ethernet 
connection to the PDDEG-S. 

	 B1	 Lighting network components
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PDTS Touchscreen
The PDTS offers intelligent control and direct access 
to scheduling, scene editing, diagnostics and local 
environmental sensing.

	 Note
The PDTS Touchscreen requires power from a 
DDNP1501 power supply.

	 B1	 Lighting network components
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B2	 Controllers

DDBC120-DALI 1-Universe DALI-2 Driver Controller
The Philips Dynalite DDBC120-DALI features a single 
DALI output, allowing to control of up to 64 DALI 
devices. It also features 1 x 20 A feed-through switched 
circuits for DALI driver mains supply.

DDBC320-DALI 3-Universe DALI-2 Driver Controller
The Philips Dynalite DDBC320-DALI features three DALI 
outputs, allowing control of up to 192 DALI devices. It 
also features 3 x 20 A feed-through switched circuits for 
DALI driver mains supply.
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DDBC1200 Signal dimmer controller
The Philips Dynalite DDBC1200 features 12 independent 
output channels, each selectable to DALI Broadcast,
0-10 V/1-10 V or DSI. The device can also be linked to 
a separate relay module for control of 0-10 V/1-10V 
drivers.

DDRC420FR Relay controller
The Philips Dynalite DDRC420FR provides control of any 
type of switched load. This four-channel device supports 
all types of switched loads up to 20 A inductive.

	 B2	 Controllers
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DDRC1220FR-GL Relay controller
The Philips Dynalite DDRC1220FR-GL provides control of 
any type of switched load. All types of switched loads up 
to 20 A inductive are supported. The maximum load may 
be limited by 500 A inrush rating.

DDMIDC8 Dry contact connections
Dry contact connections allow installation in electrical 
wall boxes for easy integration with third-party user 
interfaces. With this option it is possible to integrate 
BMS or security systems with the lighting system, by 
receiving input from the external system and run a 
special task according to the requirements. Multiple 
DDMIDC8 devices can be used in the system to add more 
dry- contact inputs required in a project.

	 B2	 Controllers
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DDNG485 RS-485/DMX512 Gateway
The Philips Dynalite DDNG485 is a flexible network 
communications bridge designed for RS-485 networks. 
The two opto-isolated RS-485 ports enable the 
DDNG485 to implement a trunk and spur topology on 
large project sites, with the bridge providing a high- 
speed backbone opto-coupled to many lower speed 
spurs.

SNS441 IA Transceiver
The SNS441 IA transceiver is the ideal solution to 
wirelessly connect luminaires connected to a DALI 
Extender or Xitanium SR Bridge to the Zigbee network. 
It uses a simple two-wire connection between 
transceiver and the SR device (SR driver or SR bridge), 
thus eliminating the need for multiple components and 
auxiliary devices. The result is a cost effective and easy 
design-in solution ideal for energy-savings. 

	 B2	 Controllers
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Xitanium SR Bridge
The Xitanium SR Bridge is used to control multiple 
luminaires with one SR sensor or to make existing 
luminaires sensor ready. The Bridge features all the 
elements of the SR interface. The SR sensor is connected 
to the Bridge via the SR interface while a group of 
luminaires can be controlled both via the Bridge DALI 
interface and the mains relay integrated in the Bridge.

DALI Extender
The DALI Extender extends the SR bus to the DALI bus 
and enables multiple applications requiring connecting 
SR devices to DALI drivers or DALI emergency drivers. 
The DALI Extender provides supply to the SR bus and the 
DALI bus.

This device enables longer cost-effective trunking lines 
with a lower number of sensors, and remote testing of 
emergency luminaires.

The DALI Extender can be installed independently or be 
built-in to luminaire.

	 Note
Currently, emergency lighting is not supported.
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B3	 Optional components

DUS360CR Multifunction sensor
The Philips Dynalite DUS360CR is a recess mountable 
360 degrees multifunction sensor that combines motion 
detection (PIR), infrared remote-control reception (IR) 
and ambient light level detection (PE) into one device in 
multiple applications.

DDNP1501 Network Power Supply
The Philips Dynalite DDNP1501 is a 15 V DC 1.5 A 
regulated power supply designed to supplement the 
Dynet network DC supply.

 

	 B3	 Optional 
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